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Kurzweil 3000® for Windows® Standalone 
Installation and Administration Guide

Kurzweil 3000 for Windows Standalone includes Kurzweil 3000 product 
DVD, containing the Kurzweil 3000 setup file; Documentation folder; and 
the Software folder with various folders, such as Utilities, Extras, and Classic 
Literature, along with documents, such as the Readme file.

Minimum Hardware and Software 
Requirements

Ensure that your system meets or exceeds these requirements:

Processor: 1.3 GHz Pentium® 4 or better.

System Memory: 2 GB.

Hard Disk Space: 2 GB free space.

Operating System: Windows 7, Windows 8, Windows 8.1, Windows 10.

Screen Resolution: 1024x768 24-bit color or better.

DVD drive, keyboard, mouse, SoundBlaster 16-bit compatible sound 
card, speakers, microphone, internet connection (for activation).

TWAIN-compatible scanner or Document camera (HoverCam or 
SCEye).

Mozilla Firefox v50 or later or Google Chrome for Read the Web 
functionality.

Internet connection required for some features (Google Translate, Online 
Book Search, Read the Web, etc.).

For Audio File Creation: MP3 encoder and/or media player.

Note: For the latest system requirements, please visit our web site: 
https://www.kurzweiledu.com/includes/new-windows-system-
requirements.html.
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Note: For use with a high-speed scanning device, contact Technical 
Support at 800-894-5374 or +1-508-315-6600 Outside US and Canada: 
if you find a device that doesn’t work.

Before You Install Kurzweil 3000 
Before installing Kurzweil 3000, you should do the following:

• Use the scanner manufacturer's instructions to install the scanner, 
software, and the scanner itself. 

• Uninstall any previous versions of Kurzweil 3000.

• Uninstall previous versions of VoiceText.

• Have your Serial Number ready.

• Depending on the Windows operating system, you may have to run 
setup.

Installing the Scanning Device

Kurzweil 3000 does not install scanners and cameras. Use the 
manufacturer’s instructions to install the device, software, and the scanner or 
camera itself. Test the device using software provided with the devices to 
ensure that the installation was successful. If you already have Kurzweil 
3000 installed and you are installing a new scanner, it is not necessary to re-
install Kurzweil 3000. 

Uninstalling Older Versions of Kurzweil 3000

Uninstalling older versions of Kurzweil 3000 does not affect user settings or 
any existing Kurzweil 3000 user files or documents.

Note: If you install the new version along with a previous version of Kurzweil 
3000, both versions are visible in Programs in the Control Panel. If, at some 
point you remove the older version, you will disable the current version. If this 
happens, Kurzweil 3000 prompts you to repair the current version, which you 
can do by inserting the product DVD and clicking the Repair option.
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To uninstall an older version of Kurzweil 3000:

1. Depending on your Windows operating system, you may have to have 
Administrator privileges to perform the uninstall. 

2. From the Windows Control Panel, select Add/Remove Programs or 
Uninstall a Program. 

3. Find and Remove Kurzweil 3000.

4. Follow the prompts.

Installing Kurzweil 3000 
You may need Administrator privilege. You can download the Kurzweil 3000 
Standalone edition from www.kurzweiledu.com/k3win or use the Kurzweil 
3000 DVD. 

Install the Software from Kurzweiledu.com Download

1. Go to www.kurzweiledu.com/k3win and select the Kurzweil 3000 
Standalone link.

2. Choose Save to save the file. This will take some time.

3. When the download has completed, double-click the .exe file to continue. 
An Installation dialog pops up.

4. Choose a destination folder for installation files to be extracted to and 
click Install. 

5. When the extraction has completed, select Install Standalone Software 
in the window that displays and follow the prompts to finish installing the 
software.

6. Restart if prompted to do so.

Install from the Kurzweil 3000 DVD

1. Place the Kurzweil 3000 DVD in the computer’s DVD drive.

2. Double-click the Setup file.
Kurzweil 3000 for Windows Standalone Installation and Administration Guide 3

https://www.kurzweiledu.com/k3win
https://www.kurzweiledu.com/k3win


3. Select Install Standalone Software in the window that displays and 
follow the prompts to finish installing the software.

4. Restart if prompted to do so.

Notes: 
• The installation automatically installs the Acapela Speaking Voices and 

American Heritage Human Pronunciation files.

• The system checks for any software updates. If an update is found, you 
can opt to do one of the following:

Choose No to not install the update and have Kurzweil 3000 launch 
normally.

Choose Don't Ask Me Again to not have the system check.

Choose Yes to install the update now. Once the install is complete, you 
can restart Kurzweil 3000.

Installing Kurzweil 3000 Using the Silent Install Option

This option installs the Standalone Client computers across your Local Area 
Network from a central location. It is provided for network administrators who 
are knowledgeable about MSI packages and have the necessary tools to 
operate directly on an MSI package.

The following must be installed before doing the MSI install:

• Microsoft .Net Framework 4.0 Full

• Microsoft .Net Framework 4.0 Full Update KB2468871

• Microsoft Visual C++ 2013 Redistributable Package x86 (all operating 
systems)

• Microsoft Visual C++ 2017 Redistributable Package x86 (all operating 
systems)

• Microsoft Visual C++ 2017 Redistributable Package x64 (64 bit OS only, 
AFTER installing the x86 packages)

You will need to specify the following arguments as properties to the Kurzweil 
3000 msi package. You must also use the Reduced UI option.
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AUTO=1 (should be a numeric value of 1, with no spaces before or after the 
'=')

EDITION="standalone"

AUTOUPDATE=0 (Zero, with no spaces before or after the '=', sets the 
automatic software update to no updates; using 1, with no spaces before or 
after the '=', sets the automatic software update to yes)

An example to launch Version 16 through command line is as follows:

msiexec.exe  /i "Kurzweil 3000 v.16.msi" AUTO=1 EDITION="standalone" 
AUTOUPDATE=0 /qn

where /i is the install switch and /qn is the No UI switch.

Acapela Voice Sets
The Default Voice set of five Acapela voices is installed automatically during 
the Kurzweil 3000 installation. The Default Voices included with Kurzweil 
3000 are:

    English USA: Heather

    English USA: Will

    English USA: Tracy

    French Canadian: Louise

    Spanish North America: Rosa

Installing Additional Acapela Voice Sets

The additional Acapela Voice sets include access to more than a dozen 
voices in a variety of languages. All except the Acapela European Voices 
Three* are available on a DVD. All voice sets can be downloaded from the 
Kurzweil 3000 website. Following are the additional voice sets and the voices 
contained in each set. 

Acapela English Non US 

Voices

Acapela European 

Voices One

Acapela European 

Voices Two
English Australian – Lisa Dutch – Femke German – Klaus
English Australian – Tyler Dutch Belgian – Jeroen German – Claudia
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*The Acapela European Voices Three is available only by downloading from 
the Kurzweil 3000 website. It is not included on the DVD.

Downloading and Installing from the Kurzweil 3000 Website
1. Go to https://www.kurzweiledu.com/k3win. Use the information shown in 

the tables above to determine the voice set to download.

2. In the list of Acapela voices, click the link next to the voice set to 
download (for example Acapela North and South American Voices).
A dialog pops up.

3. Choose Save File to save the file. This will take some time. When it has 
finished downloading, the .exe file will appear in the download folder, for 

English Indian – Deepa Dutch Belgian – Sofie Portuguese – Celia

English UK – Lucy French – Manon Italian – Fabiana

English UK – Peter French ‐ Antoine Italian – Vittorio

Acapela European 

Voices Three

Acapela North and South American 

Voices
Swedish – Emma English USA – Sharon
Swedish – Erik English USA –  Rod
Danish – Rasmus English USA – Ryan

Norwegian – Kari Spanish North America – Rodrigo

Finnish – Sanna Portuguese Brazil – Marcia
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example: AcapelaNorthAndSouthAmericanVoices_1600_W.exe.

4. Double-click the .exe file to continue. An Installation dialog pops up.

5. Choose a destination folder to extract the installation files to and click 
Install.

6. When the extraction has completed, follow the prompts in the 
InstallShield Wizard to complete the installation. 

Installing from the DVD
1. Open the folder containing the voice set that you want to install.

2. Double-click the .exe installation file to start the installation.

3. Follow the instructions to complete the installation.
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Microsoft Speech Platform
The Microsoft Speech Platform Runtime 11 delivers access to more than a 
dozen additional voices in a variety of languages. You can choose and adjust 

the many voice options to suit your individual preference.

The Microsoft Speech Platform is included on the Kurzweil 3000 DVD in a 
folder named "MicrosoftSpeech." A setup program is provided by Microsoft 
which handles the installation.

Note: These voices can be used with Windows 7, 8, 8.1 and 10.

Registering Kurzweil 3000
Registration is required for product activation. If you are a new customer or 
an existing one, you should register. If you are upgrading, you must re-
register. If you purchased multiple site licenses, register each user account.

The Registration/Activation Process

Before you start, you should have available the Serial Number of each copy 
of Kurzweil 3000 that you want to register. You can find the Serial Number on 
the product box.

When you start Kurzweil 3000 for Windows for the first time, you are 
prompted to register the product. A dialog box appears, displaying the 
methods for registration.

Registering Online

After you click the Online button, you are prompted for the following 
information from a series of dialog boxes:

1. Account Type: If this is a new registration, choose Create a New 
Account (if it is not already selected). If you have previously registered 
a different copy of Kurzweil 3000, click Use an Existing Account; it will 
reduce the amount of information you’ll need to enter.
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2. Account Name and Password: This information is used to create an 
account at Kurzweil Education that contains standard registration 
information (company, address, e-mail, etc.). You should write down your 
Account Name and Password and keep it in a secure place.

Note: Once you have submitted an Account Name and Password, an 
account is created at Kurzweil Education. If for some reason you stop the 
registration process before completion, when you resume the process, 
click the Use an Existing Account button to finish the registration 
process.

3. Registration Information: Enter the standard registration information.

4. Serial Number and Optional Purchasing Questions: Enter the Serial 
Number for the copy of Kurzweil 3000 you are registering. You can find 
the Serial Number on the product box.

Registering Copies of Kurzweil 3000 Online

If you are registering multiple copies of Kurzweil 3000, you must first fully 
register one copy as detailed in the previous section.

For subsequent registrations, do the following:

1. Start the registration process by launching Kurzweil 3000. Or, if you are 
currently in Kurzweil 3000, choose Update Registration Information 
from the Help menu.

2. In the first registration dialog box, click Online.

3. Choose Use an Existing Account, and enter the same Username and 
Password that you entered for the first copy for each additional copy. 
This causes the registration information to be filled in automatically. You 
will need to provide the Serial Number of each additional copy.

Note: If you’ve previously registered a copy but have forgotten your 
account information, choose I Forgot My Username or Password, and 
press ENTER. A dialog box appears. Enter the Serial Number for the 
copy you previously registered, and click the arrow >> button in the dialog 
box to initiate the information request.
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When Kurzweil 3000 finds your information, it sends the details to your e-
mail account. Check your e-mail for your Username and Password.

Registering by Telephone

After you click the Phone button, a dialog opens, displaying the telephone 
number for Kurzweil Education Customer Service, the System Code for this 
installation and a space to enter the Serial Number. Call the telephone 
number and give the representative the Serial Number and System Code.

Note: For phone registration, call 800-894-5374 within the United States, or 
+1-508-315-6600 from outside the United States.

The System Code Worksheet
If you are installing and registering Kurzweil 3000 on multiple machines, 
using the System Code Worksheet included at the end of this book to note 
the System Codes, Serial Numbers and Unlock Codes can greatly expedite 
the registration process.

Updating Registration Information

After you have successfully registered a copy of Kurzweil 3000, you may 
need to update your registration if for example, you move, or change your 
e-mail address, or if you are reinstalling Kurzweil 3000 for some reason.   To 
update your registration information, call Customer Service at (800) 894-
5374 within the U.S. or Canada, or +1-508-315-6600 from outside the United 
States.

Locking the Registration Process

If security is an issue at your site, consider locking the ability to update the 
registration information. You can do this in the Lock Features dialog box. For 
detailed information on locking the update process and other Kurzweil 3000 
features, see online Help.
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Using Kurzweil 3000 with Multiple Users
This section explains the use of Kurzweil 3000 with multiple users. If you use 
Kurzweil 3000 in a single-user (standalone) setting—that is, Kurzweil 3000 is 
installed on a computer and is only used by one person—you can skip this 
section.

In many instances, a single copy of Kurzweil 3000 is used by more than one 
user (that is, at different times). If you will be using Kurzweil 3000 with 
multiple users, keep the following points in mind:

• Document Organization: where documents are stored.

• User Settings (reading speed, custom toolbars): how Kurzweil 3000 
keeps track of them.

• Document Security: who can access individual users’ documents.

Kurzweil 3000 provides two methods for administering multiple users:

Method 1 — Using Windows user accounts. 

Using this method, each user logs on to the computer using a Windows user 
name and password.

Kurzweil 3000 keeps track of each user’s settings, from session to session, 
based on the Windows logon information.

With this method, each user’s documents are secure and are not accessible 
to other users. However, to ensure document security, users must remember 
to log on and log off of the computer, so that one person’s documents are not 
confused with another person’s documents.

Method 2 — Using Kurzweil 3000 multiple user accounts.

Using this method, there is usually a single Windows user account that 
corresponds to a group of users, for example a classroom. Under this 
classroom account, there are accounts for each Kurzweil 3000 user. The 
Kurzweil 3000 users access their individual accounts through the Kurzweil 
3000 Welcome dialog box.

Kurzweil 3000 keeps track of each user’s Kurzweil 3000 preferences, from 
session to session, based on the user name.
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Since access to the program is through the Kurzweil 3000-specific dialog 
box, this may provide a more intuitive experience for certain users. Also, 
users are likely to quit Kurzweil 3000 after a session, thereby minimizing the 
chance of one person’s files being confused with another person’s files. 

However, because there is no password protection, this method provides no 
security for individual users’ documents. Without password protection, it is 
easy for one user to log in as different user and access that person’s personal 
files.

Setting Up Kurzweil 3000 User Accounts for the First Time

This section shows you how to set up Kurzweil 3000 for multiple users. This 
scheme is explained in Method 2 on page 11.

To set up Kurzweil 3000 for access by multiple users:

1. Log on to the computer.

2. Double-click the Kurzweil 3000 shortcut icon on the desktop.


3. In the Kurzweil 3000 window, from the Tools menu, choose Options.

4. In the Options dialog box, click the General icon to display the General 
Options pane.

5. In the Miscellaneous area, select the Ask for User on Startup 
checkbox.

A message appears, explaining where files will be saved if you choose 
this option.
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Note: If you upgraded from a previous version of Kurzweil 3000, the Ask 
for User on Startup option will be selected and dimmed if there is more 
than one existing Kurzweil 3000 user folder.

6. Click Yes to apply the selection.

7. Click OK to close the Options dialog box.

8. From the File menu, choose Exit.

9. Double-click the Kurzweil 3000 shortcut icon to restart Kurzweil 3000.

When Kurzweil 3000 restarts, the Kurzweil 3000 Welcome window 
appears.

New user: type a Username in the text box. The next time you login, your 
username will be in the Username list. Usernames are not case-
sensitive.

Returning users: select your Username from the Username list.

10. Click OK to begin working with Kurzweil 3000.

Uninstalling Kurzweil 3000
There may be instances where you need to uninstall Kurzweil 3000, for 
example, you might need to install it on a different computer. Uninstalling 
Kurzweil 3000 does not affect user settings or any existing Kurzweil 3000 
documents or files.
Kurzweil 3000 for Windows Standalone Installation and Administration Guide 13



Be sure to review the Note on page 2 before you start to uninstall the 
previous version of Kurzweil 3000.

To uninstall Kurzweil 3000:

1. Depending on you Windows operating system, you may have to have 
Administrator privileges to perform the uninstall. 

2. From the Windows Control Panel, select Add/Remove Programs or 
Uninstall a Program. 

3. Find and Remove Kurzweil 3000.

4. Follow the remaining prompts.

Configuring the Read the Web Feature
Kurzweil 3000 Read the Web feature lets you use the Kurzweil 3000 reading 
and reference tools with content you view in a Web browser.

The Kurzweil 3000 Read the Web Extension
Kurzweil 3000 Read the Web feature lets you use the Kurzweil 3000 reading 
and reference tools with content you view in a Web browser.

The Kurzweil 3000 Read the Web extension enables the Kurzweil 3000 Read 
the Web application to work with Firefox and Chrome. This version of Read 
the Web launches your default web browser (Firefox or Chrome) from 
Kurzweil 3000, but is always available whenever you open your Chrome or 
Firefox browser.

Adding Kurzweil 3000 Read the Web as an Extension on 
Firefox

1. Open Firefox (Version 50 or greater).

2. Open Kurzweiledu.com download page (https://www.kurzweiledu.com/
news-resources/software-updates.html). 
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3. Scroll down to the Other Tools heading and find the link for Firefox Read 
the Web.

4. Click the link in the last line of the Read the Web instructions.   Note: You 
may get a warning about Firefox blocking installation.

5. Click Allow. A message appears about installing an add-on.

6. Click Install. You will get a message that it has been installed 
successfully.

7. Close the message. Open a web page (e.g., https://
www.kurzweiledu.com)

You should see the Read the Web icon in the upper right of your Firefox 
browser.

Adding Kurzweil 3000 Read the Web as an Extension on 
Chrome

1. Be sure you have the Chrome browser installed.

2. Locate the Google Search field on the Chrome browser and search for 
Chrome Web Store.

3. Click the Chrome Web Store link. The Web Store is displayed. 

4. Click Extensions. In the Search box type Kurzweil 3000. The results 
window displays Kurzweil 3000 Read the Web.

5. Click the blue +ADD TO CHROME button. A confirmation window is 
displayed.

6. Click the Add extension button. An instruction window is displayed.

Using the Kurzweil 3000 Read the Web Extension

After you have installed The Read The Web extension you can open and use 
the Read the Web feature. It works the same on Firefox as it does on 
Chrome. 
Kurzweil 3000 for Windows Standalone Installation and Administration Guide 15




To Open and Use the Read the Web Extension

1. Open a web page, then click the Kurzweil 3000 icon in the top right corner 
of the Firefox or Chrome browser. The Read the Web extension is 
displayed.

2. Log in with your Kurzweil 3000 login credentials.

3. The Read the Web Toolbar is opened and ready for you to use.

4. To open kurzweil3000.com, click the Kurzweil logo. 

5. Click the Options button to view or change the settings. Note that these 
options are in effect for the current session only and will need to be re-
selected the next time you log in. The options you select here do not 
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change any audio options in Kurzweil 3000. The reading voice that you 
are using in Kurzweil 3000 will also be used in RTW.

You can change the position of the Read the Web window using the 
Position choices at the bottom of the Options window. You can position 
the window to be displayed at the Left, Center, or Right side at the top of 
the Firefox Browser.

6. Use the Read Navigation buttons just as you do in Kurzweil 3000.  

7. Use the Audio Reading Toggle button to turn sound on or off. 

8. Use the Dictionary button to look up a selected word. 

9. Use the Translate button to translate selected text. Use the drop-down 
menu to select a language. Note: The Translate button is only available 
in the Web License Edition.

10. To shrink the Read the Web window hiding the windows, click the Toggle 
Display button at the bottom. Click it again to expand the Read the Web 
window.

Using the Kurzweil 3000 Universal Library
The Universal Library functions as a shared folder on your network where all 
users have full access. Through the Kurzweil 3000 software, users can save 
files to and open files from this shared folder.

This feature is mainly used in enterprise environments (such as schools) and 
is not recommended for home use. The Universal Library should be set up 
and maintained by Information Technology professionals.

Before you can set the Kurzweil 3000 software to access a Universal Library, 
you must first create a shared folder on your network.

Creating the Universal Library Folder

You can install a Universal Library folder in either of the following locations:

• A local, non-networked computer that has multiple users.
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• A networked computer allowing users to access the library from other 
networked computers.

Identify a Windows file sharing server to host a shared network folder. The 
shared network folder does not require its own dedicated server. On the 
server, create a shared folder that the Everyone user group has Full Control 
of.  In the example below Universal Library is the folder’s name.

Note: If you want to hide the Universal Library folder from network 
browsing, add a $ to the end of the share name in the Share name field. For 
example, Universal Library$. If you hide your Universal Library by adding 
a $ at the end of its share name, the Configure Universal Library function 
in the Kurzweil 3000 File menu will not see it. Kurzweil 3000 client can be set 
to access a hidden Universal Library folder by changing the value of a 
registry string on a computer. See below for more details.

1. Create a folder, for example Universal Library, at a location on a file-
sharing server of your choice.

2. Right-click the Universal Library folder, choose Properties, and then 
click the Sharing tab. 

3. Click the Advanced Sharing… button at the bottom of the Sharing 
window.

4. In the Advanced Sharing window that displays, check the Share this 
folder box and click the Permissions button. The Permissions window 
opens.

5. In the Permissions window select the Everyone user group, check the 
Allow box for Full Control, and click OK. The Permissions window 
closes. Click OK to close the Advanced Sharing window.

6. In the Properties window, click the Security tab.

7. In the Security tab, click the Edit… button and in the Permissions window 
that pops up, click the Add button to open the Select Users, Computers, 
Service Accounts, or Groups window.

8. In the Enter the object names to select field, type the word Everyone, 
and then click the Check Names button to resolve the user group name.
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9. Click OK to add the Everyone user group and return to the Permissions 
window.

10. Select the Everyone user group, check the Allow box for Full Control, 
and click OK to save the settings and close the Permissions window.

11. Click OK to close the Properties window.

12. You are ready to Configure Access to a Universal Library Folder for each 
computer or user that should have access to the library.

Note:  It may be possible to limit permissions of certain user groups to the 
Universal Library folder; however, using modified permissions may result in 
errors opening files from or saving files to a Universal Library.

Configuring Access to a Universal Library Folder

Once you have created the Universal Library folder, you need to provide 
access to it from each computer that will use it where Kurzweil 3000 is 
installed. There are two ways to do this: through the Kurzweil 3000 User 
Interface or through editing the registry. 

To set up access to a Universal Library folder through the 
Kurzweil 3000 GUI:

1. Start Kurzweil 3000 on a computer on which you want to set up Library 
access.

2. From the File menu, select Configure Library. The Configure 
Universal Library dialog box appears.

3. Click Change.

4. In the Browse for Folder dialog box, navigate to and select the Kurzweil 
3000 Universal Library folder.

5. Click OK.

You should now see that the commands Open from Library and Save to 
Library have been added to the File menu in Kurzweil 3000.
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To set up access to a Universal Library folder by editing the 
registry:

Kurzweil 3000 must be installed on a computer before attempting these 
steps.

1. Open the Registry Editor by typing regedit in your Start menu’s Search 
programs and files field. If User Account Control (UAC) is enabled, it is 
recommended to right-click regedit.exe and choose Run as 
Administrator.

2. Find the string:

- Windows x64: 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\KESI\Kurzweil 
3000\Installed\UniversalLibPath 
- Windows x86: 
HKEY_LOCAL_MACHINE\SOFTWARE\KESI\Kurzweil 
3000\Installed\UniversalLibPath

3. Modify the data value of the UniversalLibPath so it’s the UNC path for 
the Universal Library network shared folder. For example, 
\\<servername>\Universal Library$

You should now see that the commands Open from Library and Save to 
Library have been added to the File menu in Kurzweil 3000.

Note: Registry values can be changed on a group of computers through the 
Group Policy Management Console of your domain controller. Refer to this 
Microsoft TechNet article for more details: http://technet.microsoft.com/en-
us/library/cc753092.aspx 

Using the Universal Library

To open documents from the Universal Library:

Do one of the following:

• From the File menu, choose Open from Library.

• From the Kuzweil 3000 tab, click on Open Existing File. This opens a 
flyout menu. Select Open from Universal Library.
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The Open dialog box appears with the Universal Library folder as its 
starting point. Open the desired document as usual.

To save a document in the Universal Library:

1. Click the Save button on the Ribbon. This opens a flyout menu with Save, 
Save As, or Save to Library choices. You can also choose the Save or 
Save As command from the File menu, or press CTRL+S on your 
keyboard..

The Save As dialog box appears with the Kurzweil 3000 Universal 
Library folder as its starting point. 

2. Either navigate to the location where you want to save the document or 
click Save to save the document in the Universal Library folder.

If you are saving the document in the Universal Library folder and the 
document that you are saving is one that already exists in the folder, for 
example science worksheet, be sure to rename the document so you 
don’t overwrite this public copy. For example, you might save the 
document as jerry smith’s science worksheet.

About the Kurzweil 3000 Taskbar
The Kurzweil 3000 Taskbar, seen below, is an application that automatically 
installs with Kurzweil 3000 and appears as a small bar in the Windows 
Taskbar. 

You must show the Taskbar. See “To show or hide the Kurzweil Taskbar” 
below.
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The Kurzweil 3000 Taskbar offers fingertip access to a subset of Kurzweil 
3000 features: Read, Look Up, Spell Check, and Image Reader. You can use 
it for a single word or for a large selection of text from any application, 
including e-mail and Web browsers, that you may have on your system. 
Simply drag and drop the text directly into the Kurzweil 3000 Taskbar. 

Note: In Kurzweil 3000 Standalone edition, you can use Kurzweil 3000 
Taskbar without having to run Kurzweil 3000. For the Network edition, you 
must have a valid user license or Kurzweil 3000 must be running. 

For complete and detailed information on using Kurzweil 3000 Taskbar, place 
your cursor anywhere on the Kurzweil 3000 Taskbar and right-click to display 
its shortcut menu, and select Help.

To show or hide the Kurzweil Taskbar:
1. Click the right mouse button in an empty area of the Windows Taskbar to 

display the Windows Taskbar Shortcut menu.

2. From the Toolbars menu, click the Kurzweil 3000 Taskbar item.

To use Kurzweil 3000 Taskbar:
Type a word or phrase in the box or drag and drop or copy and paste text into 
the box from any program; Kurzweil Taskbar automatically reads the text to 
you. You can also display a dictionary entry for a word and perform a spell 
check on text.

Automatic Software Updates 
Whenever you install or launch Kurzweil 3000, the system checks for 
available software updates. To automatically have the updates installed, 
check "Turn on Automatic Update" in the General Options dialog. After the 
installation has completed, you can restart Kurzweil 3000.

If you don't have "Turn on Automatic Update" checked and updates are 
found, you will be prompted whether to install the update. You can opt to do 
one of the following:

• Choose No to not install the update and have Kurzweil 3000 launch 
normally.
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• Choose Don't Ask Me Again to disable future auto update system 
checks.

• Choose Yes to install the update now. Once the install is complete, You 
can restart Kurzweil 3000.

Notes: 

• Automatic software updates are only enabled for users with Windows 
administrative privileges. This option is grayed out for users who do not 
have Windows administrative privileges

• To receive Kurzweil 3000 updates, you may need to customize your 
Windows Firewall settings to allow Kurzweil 3000 to receive updates 
through the Firewall. 

• Restart the Kurzweil 3000 Taskbar, if desired (it is not automatically 
restarted after an update).

Firewall Settings for Receiving updates

For Windows 7, 8, 8.1, and 10:

1. Go to the Windows Control Panel.

2. In the search box, type firewall.

3. From the search results, select Windows Firewall and allow an app or 
feature through Windows Firewall.

4. In Allowed apps and features, select Kurzweil 3000.
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System Code 
Worksheet

If you are installing and registering Kurzweil 3000 on multiple machines, and 
are using the phone registration option, completing the worksheet provided 
on the next page before calling Customer Service can help to expedite the 
process. 

As you go through the installation process note the Kurzweil 3000 product 
Serial Number and System Code for each machine. They are necessary for 
obtaining a corresponding Unlock Code, which you will then need to 
activate each installation of the software. 

Space is also provided on the worksheet for the location of each machine, 
and for the corresponding Unlock Code which the Customer Service 
representative will provide to you.

Note: You can display a machine’s System Code by clicking the Phone 
button in the initial registration dialog box.

For complete details and instructions on product registration, and 
specifically, Registering by Phone, see Registering Kurzweil 3000 on page 8.
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System Code Worksheet
Machine Location Product Serial 

Number
System Code for 
Machine

Unlock Code 
(provided by Kurzweil 

Customer Service)
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System Code Worksheet
Machine Location Product Serial 

Number
System Code for 
Machine

Unlock Code 
(provided by Kurzweil 

Customer Service)
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